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Vision Statement
Dutchess BOCES is recognized for its premier educational and support services providing quality and cost-
effective solutions for our community.  We promote an organizational culture fostering collaboration, innova-
tion, efficiency, excellence and leadership that is embraced by BOCES and its community.

Mission Statement
The Board of Cooperative Educational Services provides educational leadership through service, solutions and 
savings.

Dutchess BOCES Goals
 • Raise the academic performance of all students in Dutchess County.

 • Provide staff development appropriate to fulfill the BOCES mission.

 • Collaborate with other BOCES, school districts and county agencies to fulfill the mission.

BOCES Belief Statement
 • Learning is a lifelong endeavor.

 • Teaching and learning are at their best in a diverse environment that fosters cooperation and un-
derstanding through collaboration and communication.

 • Mutual respect, fairness, support and honesty create quality relationships.

Title IX and 504 Compliance
Dutchess BOCES offers employment and educational opportunities without regard to sex, race, color, national 
origin or disability. Inquiries regarding this non-discrimination policy may be directed to the following indi-
vidual.
This official will provide information, including complaint procedures to any citizen, student or employee who 
feels that his or her rights under Title IX or Section 504 may have been violated by the BOCES or its officials:

Anna Marie Paolercio 
Director - Communications and Grants Research 
Dutchess BOCES BETA 
900 Dutchess Turnpike 
Poughkeepsie, NY 12603 
voice:  845.486.8051  
fax:  845.486.4958
anna.paolercio@dcboces.org

DUTCHESS BOCES
GENERAL INFORMATION



Dutchess BOCES Style Guide and Communications Manual
To achieve consistency in Dutchess BOCES written and oral communications, the Communications and 
Grants Research Division (CGR)  developed an editorial style guide for the Dutchess BOCES community. The 
Dutchess BOCES Style Guide and Communications Manual establishes preferences in the punctuation and style 
of many commonly used words and phrases in our educational environment. The style guide offers general 
editorial guidelines in a number of other troublesome areas for writers and editors. In addition, it is a source to 
refer to when looking for Dutchess BOCES division names, building names, school names, Dutchess BOCES 
programs and services, as well as tips on providing excellent customer service. The Dutchess BOCES Style Guide 
and Communications Manual often cross-references the current Dutchess BOCES Services Guide, information 
regularly updated on GroupWise and the Dutchess BOCES Web site.
Using a standard, consistent style throughout Dutchess BOCES helps serve our clientele with clear, coherent 
communications and further ensures that all Dutchess BOCES communications adhere to a high level of qual-
ity and attention to detail.

Editorial Style Guides
Educational style guides have as their foundation one or two widely used editorial style manuals and 
dictionaries. Dutchess BOCES uses The Associated Press Stylebook and the Publication Manual of the American 
Psychological Association as its primary style guides. Our primary reference book on spelling is Webster’s II New 
College Dictionary.

Publication Manual of the American Psychological Association, Fifth Edition, American Psychological 
Association, Washington DC, 2002
The Associated Press Stylebook, 39th Edition, Associated Press, Editor Norm Goldstein, New York, NY, 2004
Webster’s II New College Dictionary, Houghton Mifflin Company, Boston and New York, 2001

Additional Assistance
For further assistance, please contact the Communications and Grants Research Division at 845.486.8051 or 
e-mail anna.paolercio@dcboces.org.  We welcome your suggestions for additions to The Dutchess BOCES Style 
Guide and Communications Manual.

Anna Marie Paolercio
Director - Communications and Grants Research
Dutchess BOCES
900 Dutchess Turnpike, Poughkeepsie, NY 12603
voice: 845.486.8051 ~ fax:  845.486.4958
anna.paolercio@dcboces.org
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Section One: Dutchess BOCES General Terminology 

Names of Dutchess BOCES Programs and Services
For marketing and promotional purposes, the preferred name is DUTCHESS BOCES.  Please find the most current 
Dutchess BOCES program names and services in the Dutchess BOCES Services Guide, which can be found at http://
www.dcboces.org/publications/servicesguide.pdf
Dutchess BOCES is part of the statewide system of Boards of Cooperative Educational Services.  Through the coop-
erative efforts of our thirteen component school districts, Dutchess BOCES is able to offer a wide variety of educa-
tional programs and support services to children and adults in Dutchess County.  Costs are reduced by having two 
or more districts share in these programs and services.  Participating districts are eligible for state aid for BOCES 
services.  All services benefit from the professional advice and suggestions of component district personnel.
Dutchess BOCES always stands ready to develop additional services tailored to the needs of two or more districts. 
Suggestions for new services can be directed to the District Superintendent or the appropriate division head.

Names of Divisions
Adult Learning Institute Communications and Grants Research
Alternative and Special Education District Superintendent’s Services 
Business Services Educational Resources 
Career and Technical Institute Facilities and Operations 
 Human Resources 

Building and Program Locations
Career and Technical Institute (CTI) 
5 BOCES Road  
Poughkeepsie, NY 12601 
845.486.8001
 Educational Resources
 High School Programs
 School of Practical Nursing 

Educational Resources 
Career and Technical Institute
5 BOCES Road  
Poughkeepsie, NY 12601 
845.486.4840
 Learning Technology 
 School Improvement

Salt Point Educational Center (SPC) 
5 BOCES Road 
Poughkeepsie, NY 12601 
845.486.8004
 Academic, Behavior and Curriculum
 Adolescent Day Treatment
 Facilities and Operations 
 Intensive Day Treatment
 Safety and Risk
 Special Education

Administration Building 
5 BOCES Road  
Poughkeepsie, NY 12601 
845.486.4800
 Business Services
 District Superintendent’s Services
 Human Resources

Adult Learning Institute (ALI)
One Civic Center Plaza, Suite 300  
Poughkeepsie, NY 12601 
845.483.3640
 Adult Education Programs 
 Community Solutions for Transportation

BOCES Educational Training Academy (BETA) 
900 Dutchess Turnpike 
Poughkeepsie, NY 12603 
845.486.4840
 Alternative Education
 Communications and Grants Research
 Mid-Hudson Regional Special Education Technical
  Assistance Support Center (RSE-TASC)
 Shared Printing Service
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BOCES Administration BOCES Board of Trustees
JOHN C. PENNOYER

District Superintendent

LINDA A. HEITMANN
Deputy Superintendent

SHERRE WESLEY
Assistant Superintendent for Business Services

•
MATTHEW CARR

Business Administrator for Human Resources

CECILIA DANSEREAU-RUMLEY
Director - Mid-Hudson RSE-TASC

NORAH MERRITT
Director - Alternative and Special Education

ANNA MARIE PAOLERCIO
Director - Communications and Grants Research 

MITCHELL SHRON 
Supervisor /Principal - Career and Technical Institute

MARY FAYNE SIMPSON
Adult Education Administrator

EDWARD L. McCORMICk
President

MICHAEL RIEHL
Vice President

RALPH CHIUMENTO, JR.

THOMAS HURLEY

THOMAS JOHNSON

ROBERT M. MEADE

JIM MILANO

NANCY PISANELLI
Clerk of the Board



www.dcboces.org 3

Arlington Central School District
Lorenzo Licopoli 
Interim Superintendent 
144 Todd Hill Road 
LaGrangeville, NY 12540 
Tel:  845.486.4460 
Fax:  845.486.4457 
llicopoli@acsdny.org 

Beacon City School District
Raymond Bandlow 
Superintendent 
10 Education Drive 
Beacon, NY 12508 
Tel:  845.838.6900 
Fax:  845.838.6905 
bandlow.r@beaconk12.org

Dover Union Free School District
Michael Tierney 
Superintendent 
2368 Route 22 
Dover Plains, NY 12522 
Tel:  845.832.4500 
Fax: 845.832.4511 
mike.tierney@doverschools.org

Hyde Park Central School District
Greer F. Fischer 
Superintendent 
11 Boice Road 
PO Box 2033 
Hyde Park, NY 12538 
Tel:  845.229.4005  
Fax: 845.229.4056  
greer.fischer@hydeparkschools.org

Millbrook Central School District
R. Lloyd Jaeger 
Superintendent 
PO Box AA 
Millbrook, NY 12545 
Tel:  845.677.4200 
Fax: 845.677.4206 
lloyd.jaeger@millbrookcsd.org

Pawling Central School District
Joseph Sciortino 
Superintendent  
515 Route 22 
Pawling, NY 12564 
Tel:  845.855.4600 
Fax: 845.855.4659 
sciortinoj@pawlingschools.org 

Pine Plains Central School District
Linda L. kaumeyer 
Superintendent 
2829 Church Street 
Pine Plains, NY 12567 
Tel:  518.398.7181 
Fax: 518.398.6592 
l.kaumeyer@ppcsd.org

Poughkeepsie City School District
Laval S. Wilson 
Superintendent  
11 College Avenue 
Poughkeepsie, NY 12603 
Tel:  845.451.4900 
Fax: 845.451.4954 
lwilson@poughkeepsieschools.org 

Red Hook Central School District
Paul Finch 
Superintendent 
9 Mill Road 
Red Hook, NY 12571 
Tel:  845.758.2241 
Fax: 845.758.3366 
pfinch@rhcsd.org 

Rhinebeck Central School District
Joseph Phelan 
Superintendent 
PO Box 351 
Rhinebeck, NY 12572 
Tel:  845.871.5520   
Fax: 845.876.4276 
jphelan@rhinebeckcsd.org

Spackenkill Union Free School District
Lois Powell 
Superintendent  
15 Croft Road 
Poughkeepsie, NY 12603 
Tel:  845.463.7800 
Fax: 845.463.7804 
lois.powell@spackenkillschools.org

Wappingers Central School District
James Parla 
Superintendent 
167 Myers Corners Road, Suite 200 
Wappingers Falls, NY 12590 
Tel:  845.298.5000 
Fax: 845.298.5041 
james.parla@wappingersschools.org 

Webutuck Central School District
James Gratto, Jr. 
Superintendent 
194 Haight Road, PO Box N 
Amenia, NY 12501 
Tel:  845.373.4100 
Fax: 845.373.4102 
jgratto@webutuckschools.org

Names of Dutchess County Schools
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Abbreviations, acronyms
Abbreviations and acronyms should be used spar-
ingly and only after spelling out the words on first 
usage.

Students who earned a 3.5 grade point average 
(GPA) or above and maintained at least 12 credit 
hours were named to the Dean’s List last spring. 
They need to maintain a GPA of at least 3.5 each 
semester to remain on the Dean’s List.

Exceptions can be made for widely understood 
acronyms such as FBI and CIA.

Academic courses
Capitalize the proper names of individual courses: 

First-year students take Writing I, a required 
humanities course.

Fields of study in general should be written in 
lowercase unless they include a proper noun or 
adjective. 

She studies biology, but her brother is interested 
in American history and English.

Academic degrees
Abbreviations of academic degrees require a period 
after each element in the abbreviation but no inter-
nal spaces: Ph.D., M.A., B.A., B.S.
When academic degrees follow a person’s name in 
the middle of a sentence, the degree is set off by 
commas.

 Joseph Carroll, Ph.D., was the featured speaker.
Capitalize full and formal names of specific de-
grees: Bachelor of Science, Doctor of Philosophy. 
When referring to academic degrees in general, 
lowercase the first letter of the degree and use 
an apostrophe: bachelor’s and master’s degrees, 
not bachelors and masters degrees. Baccalaure-
ate, a synonym for bachelor’s degree, also refers to 
speeches delivered to graduating classes and should 
be lowercase.
Doctoral is an adjective and doctorate is a noun.

They all earned doctoral degrees. They all earned 
doctorates.

The most common degrees include B.A. (Bachelor 
of Arts), B.S. (Bachelor of Science), B.F.A. (Bach-
elor of Fine Arts), M.A. (Master of Arts), M.S. 
(Master of Science), Ed.D. (Doctor of Education), 

Section Two:  Language, Terminology and Grammar
Ph.D. (Doctor of Philosophy).Do not use a courtesy 
title such as Dr. and Mrs. when including an indi-
vidual’s academic degree.

Dr. Arnold Robinson or Arnold Robinson, Ph.D., 
not Dr. Arnold Robinson, Ph.D. 

List only the highest degree a person has received.
Tammy Smith, Ph.D., not Tammy Smith, B.A., 
M.A., Ph.D.

Academic departments, programs, and 
services
According to Dutchess BOCES preference, capi-
talize the name of a division, office, service, or 
program and the word division, office, service and 
program only when they appear as part of an official 
name.

Human Resources Division, Office of Commu-
nications and Grants Research, Microcomputer 
Repair Service.  

On subsequent references, do not capitalize division 
or program when standing alone.

She is a staff member in the Educational Re-
sources Division.  Each month she attends the 
division’s staff meeting.
Several first-year students expressed strong inter-
est in the BOCES Career and Technical Educa-
tion’s Cosmetology Program.  The program is 
located at the Career and Technical Institute.  

Official names of departments and programs can 
be found in the most recent edition of the Dutchess 
BOCES Services Guide.

Academic titles (see Titles)
Capitalize a person’s title when put before the name.

District Superintendent John C. Pennoyer
Do not capitalize titles when listed after a name or 
titles that do not include a name.

Anna Marie Paolercio, director of Communica-
tions and Grants Research, led the discussion.
Let’s invite the vice president to the event.

Advisor
Use advisor and not adviser.
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Advisory bodies
Capitalize references to a specific body of advisors, 
including the Alumni Council, Board of Trustees, 
President’s Advisory Council. When using board or 
council alone in subsequent references, use lowercase.

BOCES Board of Trustees meets once a month. 
The board’s meetings are listed in the official 
Dutchess BOCES annual calendar.

Affect, effect
Each is used as a verb and a noun. In practice, how-
ever, affect is used most often as a verb and usually 
means to influence or change.

Many drugs affect the nervous system. 
Affect as a verb can also mean to feign or simulate.

He affected poor grades to gain sympathy. 
When used as a noun, affect means a feeling or 
emotion (as distinguished from thought or action).
Effect is used most often as a noun and means a 
result or outcome.

Many drugs have serious effects on the nervous 
system. 
His complaints had no effect on the dean.

When used as a verb, effect means to cause or bring 
about.

To effect change in the patient’s condition, physi-
cians had to use drugs.

Allude, elude
To allude is to make an indirect reference to some-
thing. To elude someone or something is to avoid, 
evade or escape from the person or thing.

Alumni
Class years should appear after a graduate’s name 
in publications.  Identify Dutchess BOCES alumni 
by their class year(s) with an apostrophe before the 
year. The apostrophe should slant to the right.

Lisa Owens, BETA ’94 plans to attend Reunion 
Weekend next fall.

Identify alumni in the following manner: 
alumna:  feminine singular
alumnae:  feminine plural
alumnus:  masculine singular
alumni:  masculine plural or masculine and 
feminine plural
She is a Dutchess BOCES BETA alumna.
The alumni held their Reunion Banquet at a local 
restaurant.

Ampersand
Use an ampersand in corporate titles only when it is 
part of the official title.

Sherman, Cooper & Leeds
Do not use an ampersand with courtesy titles in 
text.  

Incorrect:  Mr. & Mrs. Sanford will attend.
Never use an ampersand instead of the word and in 
text.

Career and Technical Education

Anybody, any body, anyone, any one
Use anybody or anyone (one word) when making an 
indefinite reference.

Anyone can do it.
Use any body or any one (two words) when empha-
sizing or singling out one element of a group.

Any one of them can do it.

Apostrophe
Use apostrophes in contractions or to show posses-
sion.

It’s time for class to begin.  Get John’s books.
Do not use an apostrophe when forming plurals of 
dates or acronyms.

1890s, 1920s, 1990s, M.D.s, Ph.D.s
Names of people and other proper nouns form the 
plural in the usual way by adding s or es

The Danforths attended the ceremony, but the     
Joneses could not attend.

Follow these guidelines for possessives:
Plural nouns not ending in s:  add ’s

The alumni’s contributions; women’s rights
Plural nouns ending in s:  add only an 
apostrophe

The girls’ books; states’ rights
Nouns plural in form, singular in meaning: add 
only an apostrophe.

mathematics’ rules; the United States’ population
Nouns spelled the same in singular and plural 
meaning:  treat as plural nouns.

A corps’ location; two corps’ troops
Singular nouns not ending in s:  add ’s

The student’s notebook
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Singular nouns ending in s sounds such as ce, x, 
and z: add ’s (stylebooks vary on this rule).

Marx’s theories; the justice’s decision
Singular nouns ending in s:  add ’s unless the next 
word begins with an s.

The hostess’s invitation; the hostess’ seat
Singular proper names ending in s:  use only an 
apostrophe.

Achilles’ heel; Dickens’ novels; Williams’ plays

Board of Trustees
(Also see Advisory bodies)

Capitalize when using these official names.  In 
subsequent references, lowercase the board and 
trustees when the word stands alone.

The Board of Trustees began the meeting. The 
board members discussed funding for the new 
science center.

Uppercase Trustee when it precedes a person’s 
name. Use lowercase when the title follows the 
person’s name.

Trustee Jean Harding Pierce ’97 is a Beta alumna.
Peter Danforth, trustee, lives in the New London 
area.

Buildings, facilities
In text, use the full name of Dutchess BOCES facili-
ties in the first reference and the shortened version 
in subsequent mentions within shorter documents. 
In longer documents, the full names will need to 
be mentioned more often; introduce the full name 
in each new chapter or section of long texts.  Each 
Dutchess BOCES facility is listed on Page 1 under 
Section One of this guide, along with its full name and 
acceptable abbreviated version (when applicable).

Capitalization
Capitalize the following words or phrases:  the 
formal or full names of Dutchess BOCES divisions, 
events, initiatives, offices, organizations, programs 
and publications.
Capitalize people’s titles only when they precede 
the individual’s names. In general, capitalize proper 
nouns (English Channel) and popular names of 

events, places, etc. (World Series, Ivory Tower).
Below is a list of words and phrases that are com-
monly used (or that have recently come into use) at 
Dutchess BOCES. According to the capitalization 
guidelines mentioned above, most of these words 
or phrases require capitalization (uppercase ini-
tial letter in each word/phrase).  Those that do not 
require capitalization refer to initiatives or programs 
in general rather than to a specific Dutchess BOCES 
initiative or program.

 • Adult Education

 • Alternative Education

 • Arts in Education

 • Alternative High School

 • Business Services

 • Career and Technical Education

 • Career and Technical Institute

 • Communications and Grants Research

 • Cooperative Transportation

 • Day Treatment Programs

 • Educational Resources

 • Excess Cost Aid

 • Facilities and Operations

 • Human Resources

 • Microcomputer Repair

 • Mid-Hudson Cooperative Recruitment

 • Model Schools

 • New Visions

 • Salt Point Education Center

 • Special Education

 • State Education Department

Chairman, chairwoman, chairperson
Chair is preferred.

She is the department chair.
Use chair unless a particular individual expresses 
another preference. 
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Clubs, committees, councils
The full and official names of clubs, committees, 
and other organizations and groups should be capi-
talized. In subsequent references, when referring to 
the club or team, use lowercase.

Coed, coeducational 
No hyphen. Use coeducational in print rather than 
the informal coed. Coeducational refers to students 
of both sexes. Never use coed to refer to a female 
student.

Commas 
Following are the Associated Press Stylebook’s pref-
erences for comma placement.

 • Dates: Do not use a comma between month and 
year or season and year: April 1993; fall 1994. Use 
a comma between specific date and year: April 
3, 1994. A comma should follow the year when a 
specific date is mentioned in mid-sentence:  Feb. 8, 
1990, was the date of the party.

 • Dependent clauses: If the second half of a com-
pound sentence does not contain its own subject 
and verb, do not separate the clauses with a comma:  
The Box Office is located in the Sawyer Fine Arts 
Center and opens before major campus events.

 • Independent clauses: Use a comma between the 
two independent clauses of a compound sentence 
(preceding the conjunctions and, but, or, nor, for, so, 
and yet). The second half of the sentence must con-
tain its own subject and verb:  Conference Room 
301 is located in the Career and Technical Institute 
on the Salt Point Campus, and it is often used for 
workshops and conferences.

 • Introductory elements: Use commas after intro-
ductory elements, interjections, and direct ad-
dresses:  If the research grant is awarded, we will 
begin the project at once. In addition, we will write 
the article.

 • Locations: When using a city name with a state or 
country name, place a comma after each element:  
She is a Huntsville, Alabama, native.

 • Series: Use commas to separate items in a series, 
but do not put a comma before the conjunction in a 
simple series:  The flag is red, white and blue.

 • Do put a comma before the concluding word or 
phrase in the following instances: if an element 
requires a conjunction (We had orange juice, toast, 
and ham and eggs for breakfast); or if the conjunc-
tion concludes in a complex series of phrases (The 

main issues to consider are whether the students 
have attended the class regularly, whether they have 
completed the required assignments each week, and 
whether they have engaged in classroom discus-
sions).

 • With equal adjectives: Use commas to separate 
series of adjectives equal in rank. (If the commas 
could be replaced by the word and without chang-
ing the meaning, the adjectives are equal:  a dark, 
dangerous street.) Use no comma when the last 
adjective before a noun outranks its predecessors 
because it is an integral element of a noun phrase, 
which is the equivalent of a single noun:  a cheap 
fur coat, a private liberal arts college. (The noun 
phrases are fur coat and liberal arts college.)

Compose, comprise
Compose means to create or put together and can be 
used in both active and passive voices.

She composed a song.
The United States is composed of 50 states.

Comprise means to contain, to include all or em-
brace and is followed by a direct object.

The United States comprises 50 states.

Composition titles
Italicize titles of books, journals, magazines, newspa-
pers, newsletters and long poems published as books. 
When the surrounding text is already italicized, set 
the title or word in regular type (no italics).
Place the names of articles, exhibitions, films, lectures, 
plays, songs and television shows in quotation marks.

COSER
Acronym for the SED’s reference to Cooperative 
Service. On publications use all caps and no hyphen.

Coworker
No hyphen. (Also see Hyphenation)

Council/Counsel
Council is a deliberative body and those who are 
members of it.
Counsel is to advise.

Courseload, coursework 
One word. No hyphen. (Also see Hyphenation)
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Courses
Classes and courses should be lowercase when 
making a general reference to courses, unless the 
subject includes a proper noun or adjective.

He studies history, political science and English. 
Classes should begin with an uppercase when 
referring to a specific class or when the class name 
includes a proper noun or adjective.

She took PSY 101: Introduction to Psychology 
and SPA 101: Elementary Spanish.

Do not use course abbreviations in a sentence.
Correct:  He took Spanish and psychology 
classes.
Incorrect:  He took SPA and PSY classes.
She is a sophomore biology major, yet her 
younger brother would like to study English.

Currently, presently 
Currently means now; presently means in the near 
future.

Curriculum 
Use curricula or curriculums in plural form.

Dash 
There are several types of dashes:  the hyphen, the 
en dash, the em dash, the 2-em dash, and the 3-em 
dash. The following are the most common uses:

 • En dash (-): Use to indicate continuing or inclu-
sive numbers or time periods. Do not insert spaces 
before and after the dash: 1964-1965; March-June 
1991.

 • Em dash (—): Use to indicate a sudden break 
to inject explanatory or qualifying material into a 
sentence. Do not insert spaces before and after the 
dash:  The people—the ones who were the most 
interested—made a special effort to attend the 
meeting.

 • 2-Em dash (——): Use to indicate missing letters. 
Do not place a space between the existing part of 
the word and the dash, but do add a space where 
the dash represents the end of the word: I read the 
s—— section of the newspaper.

 • 3-Em dash (———): Use to indicate a missing word 
or words to be supplied. Add a space before and after 
the dash: The express truck was bound for ——— and 
would arrive late.

Data, datum 
Datum is singular, and data is its plural form.

Dates
Days:  Always spell out days of the week.
Months:  Always spell out the months with fewer let-
ters:  March, April, May, June, July. Never abbreviate 
any months when they do not immediately precede 
a date. When followed by a number, abbreviate Jan., 
Feb., Aug., Sept., Oct., Nov., Dec.:  April 5 and Dec. 
25.  Consecutive dates can be written in one of two 
ways:

     The workshop will be held Jan. 2 to 25. 
     The workshop will be held Jan. 2-25.

Use through when event duration extends to next 
month.

Rehearsals will run from March 25 through April 5.
Years:  Use figures without commas: 1995. Use an s 
without an apostrophe to indicate spans of decades 
or centuries:  the 1990s, the 1800s.
For expressing students’ or graduates’ class years, 
use an apostrophe after the name and the decade of 
graduation.

Sarah Weiner ’96 and Ed Johnson ’97 attended 
the wedding of Jodie Marston ’98.

Decades:  Use numerals to indicate decades of his-
tory.

He began college in the ’90s.
Use an apostrophe to indicate numerals that are 
missing and add an s to indicate the plural: the ’90s, 
the Roaring ’20s.
Centuries:  Lowercase century, spelling out numbers 
less than 10:  the first century, the 21st century.

Divisions, offices  
(Also see Academic departments and Offices)

Capitalize the words division and office when they 
appear with official divisional names.

The Educational Resources Division will host a 
poetry reading.
 The Benefits Office will hold a session on health 
insurance options.  



www.dcboces.org 9

e.g./i.e.
When you mean for example, use e.g.  It is an abbre-
viation for the Latin phrase exempli gratia.  
When you mean that is, use i.e.  It is an abbrevia-
tion for the Latin phrase id est.  
Either can be used to clarify a preceding statement, 
the first by example, the second by restating the 
idea more clearly or expanding upon it.  Because 
these uses are so similar, the two abbreviations are 
easily confused.  To be safe, simply use the words 
for example and that is.  If you insist on using the 
abbreviation, perhaps example given will remind 
you to use e.g., while in effect suggests i.e.  Since e.g. 
indicates a partial list, it is redundant to add etc. at 
the end of a list introduced by this abbreviations.

E-mail
Hyphenate and use lowercase e in e-mail unless the 
word begins a sentence. E-mail addresses should 
be written as follows: john.smith@dcboces.org.  In 
printed texts, do not italicize, bold, underline or use 
all capital letters in e-mail or Web addresses.

Emerita, emeritus, emeriti
These honorary titles are formally designated to 
specific individuals who have retired from their 
positions and should be used in conjunction with 
these individuals’ formal titles. Similar to the word 
alumni, the endings used with emeriti vary accord-
ing to gender and singular/plural references. Do 
not use italics for these commonly used words.

emerita: single feminine
emeritus: single masculine
emeriti: plural masculine/feminine/both

The emeriti honorary title is used in conjunction 
with the formal title and can precede or follow 
the person’s name. Titles that precede a formal 
name are capitalized, and those that follow are 
lowercased. When standing alone, titles are always 
lowercased.

John Smith, professor emeritus, attended Com-
mencement this year.
Dean Emerita Joan Baez retired in 1968.

Events, initiatives
Capitalize the full names of formal events and 
special services held at Dutchess BOCES such as 
Commencement, New Hire Orientation, Reunion, 
Student Orientation.  Lowercase abbreviated ver-
sions of the formal event.

The new students must attend Student  
Orientation.
They receive orientation materials at the registra-
tion desk.

Faculty
A plural noun that refers to Dutchess BOCES teach-
ers and instructors. Lowercase faculty unless the 
word is part of a specific name or title.

Foreign words or phrases
Foreign words and phrases may be set off in italics 
if they are likely to be unfamiliar to readers. Many 
foreign phrases used in academe, including Latin 
honors such as cum laude have become established 
parts of the English language and should be set in 
regular type. Additionally, foreign phrases that have 
been adopted as names of national honor societies 
and fraternities/sororities do not require italics:  Al-
pha Chi, Sigma Chi. (If the word or phrase appears 
in an English dictionary, it’s safe to assume it’s a 
familiar word and does not require italics.)

Gender
Avoid ambiguity in sex identity or sex role by choos-
ing nouns, pronouns, and adjectives that specifi-
cally describe your subject.  Be clear about whether 
you mean one sex or both sexes.  There are many 
alternatives to the generic he, including rephras-
ing (e.g., from “When an individuals conducts this 
kind of self-appraisal, he is a much stronger person” 
to “When an individual conducts this kind of self-
appraisal, that person is much stronger” or “This kind 
of self-appraisal makes an individual much stron-
ger”), using plural nouns and plural pronouns (e.g., 
from “A therapist who is too much like his client can 
lose his objectivity” to “Therapists who are too much 
like their clients can lose their objectivity”), replacing 
the pronoun with an article (e.g., from “A researcher 
must apply for his grant by September 1” to “A re-
searcher must apply for the grant by September 1”), 
and dropping the pronoun (e.g., form “The researcher 
must avoid letting his own biases and expectations” to 
“The researcher must avoid letting biases and expec-
tations”).  The preferred style is to use (s)he.  Replac-
ing he with he or she or she or he should be done spar-
ingly because the repetition can become tiresome.  
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Gifted and Talented
The federal Elementary and Secondary Education 
Act (ESEA) defines gifted and talented students as 
“Students, children, or youth who give evidence of 
high achievement capability in areas such as intel-
lectual, creative, artistic, or leadership capacity, or 
in specific academic fields, and who need services 
and activities not ordinarily provided by the school 
in order to fully develop those capabilities.” [Title 
IX, Part A, Definition 22. (2002)]  Many states and 
districts follow the federal definition. 

Graduate 
Lowercase when referring to the general status of a 
graduate.

Tom Reynolds is a graduate of the college.

Home page
Do not capitalize home page unless it begins a sen-
tence.

Hyphenated words 
When in doubt about whether to hyphenate a 
word, consult your dictionary.  Use a hyphen to 
avoid ambiguity and in the following situations:

 • Compound modifiers:  In general, when two or 
more words modify a noun, use hyphens: a three-
year-old child, a well-known physician. Do not 
hyphenate compounds that include very or adverbs 
ending in ly:  a very delicate procedure, an expertly 
performed operation.  Most compound modifiers 
are not hyphenated when they appear after a noun. 
The exception to this is modifiers that follow forms 
of the verb to be.

The program, well known for its success, is part 
of the School of Education. 
The program is world-renowned. 

However, compounds with the prefix well are 
usually not hyphenated when they follow forms 
of to be.
 • Compound words: Avoid hyphenating compound 

words whenever possible, unless hyphens are nec-
essary to avoid confusing the reader or to avoid an 
awkward junction:  coworker, freelance, inpatient, 
statewide, nonresident, and noncredit
Check a current dictionary for specific words.  
Certain compound words should be spelled as two 
words when used as adverbs or nouns, (full time, 
part time, off campus) but hyphenated when used 
as adjectives.

She has a part-time job in order to attend school 
full time. 

Use a hyphen when the base word begins with a 
capital letter:  non-American.

 • Breaks: If a word already contains a hyphen, do 
not break it at the end of a line.  Do not allow a 
single letter of a word to stand alone at the begin-
ning or end of a line.

Internet
Always capitalize the word Internet.

It’s, its 
It’s is a contraction that means it is, or it has. Its 
means belonging to it.

It’s going to be a great year.
The dog wagged its tail.

Italics
In general, italicize titles of films, books, journals, 
magazines, newspapers, newsletters and long poems 
published as books.
Use quotation marks for articles, exhibitions, 
lectures, plays, short poems, songs and television 
shows. Italicize foreign language words and phrases 
if they are likely to be unfamiliar to readers. When 
the surrounding text is already italicized, set the 
title, word or phrase in regular type (no italics). 
(Also see Foreign words or phrases)

Jr., Sr., II, III
Do not precede Jr. and Sr. or numerals with a 
comma unless the named individual has indicated a 
preference for it.

John Smith Sr. is a newly appointed trustee.
Logos
To obtain digital files or copies of Dutchess BOCES 
official logo, as well as other BOCES related logos, 
usage and guidelines, contact the Communications 
and  Grants Research Division at 845.486.8051 or 
e-mail Anna Marie Paolercio at anna.paolercio@
dcboces.org.

Money
Use the dollar sign and numbers when representing 
money in text. Do not use a decimal and two zeros 
unless the number of cents must be specified.

She spent $25 on her psychology textbook and 
$8.50 on new stationery.
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For amounts of $1 million or more, use the $ sign 
and numerals up to two decimal points. In gen-
eral, avoid long numbers with lots of zeroes, as in 
7,000,000,000. Do not link the numerals and the 
word by a hyphen.

The benefactor established a new $1.5 million 
endowment. The building will cost $3,500,500.

Names 
With the first reference in formal prose, use a 
person’s full name and title; in the second reference, 
use the title and last name of the individual when 
the title is significant with the context. Otherwise, 
use the person’s last name only in subsequent refer-
ences. With students, use their full name in the first 
reference and only their last name in subsequent 
references. (In some informal texts or correspon-
dence, the person may be referred to by their first 
name in subsequent references.) 

John Jeffrey, principal of the Alternative High 
School, attended a conference on best practices.  
Afterward Principal Jeffrey presented a report to 
fellow administrators.  
Joe Samson ’07 met with his advisor for the first 
time this week. Joe discussed his interest in add-
ing another course to his schedule.

Nondiscrimination 
All Dutchess BOCES communications should 
reflect our commitment to equal opportunity and 
nondiscriminatory practices in all aspects of em-
ployment and education. Respect and a balanced 
representation should be given regarding gender, 
race, ethnic group, age and ability. Nondiscrimina-
tory principles apply to all written materials.

Numbers (Also see Money)
In text, write out numbers one through nine. Use 
figures for numbers 10 and above. Use figures when 
numbers are preceded by a dollar sign unless it is 
the first word in the sentence. In amounts less than 
a dollar, write as figures and spell out the word 
“cents.” With percentages, use figures and write out 
“percent.”

There are seven women and 11 men in the group.
The residence hall is 50 percent male.
A small cup of coffee costs 85 cents at the cafeteria.

Offices
Capitalize the word office when used with the 
official name of a work unit:  Admissions Office, 
Business Office. In subsequent references, lowercase 
office when it stands alone.
Capitalize Payroll, Benefits, Human Resources and 
other offices whose names are recognizable even 
without the word office.

Over, More than
Over refers to spatial relationships.

The shelf is over my head.
More than refers to numbers or amounts.

The group raised more than $60. More than 50 
people attended. 

People with Disabilities
Put the person before the disability. For example, 
use people with disabilities as opposed to disabled 
people or the disabled.
Do not use phrases such as confined to a wheelchair, 
crippled, afflicted, victim of or suffers from a disorder. 
These references diminish the individual’s dignity 
and magnify the disability. Instead, refer to the 
person who uses a wheelchair or the person with an 
emotional disorder. Avoid using trendy euphemisms 
to describe people with disabilities. Expressions 
such as physically challenged, special and handi-
capable generally are regarded by the disability 
community as patronizing and inaccurate.  Stick 
with simple language, such as people with disabilities 
or the person who is deaf.
Impairment is used to characterize a physical, 
mental or physiological loss, abnormality or injury 
that causes a limitation in one or more major life 
functions. For example, The loss of her right arm was 
only a slight impairment to her ability to drive.
Disability refers to a functional limitation that af-
fects an individual’s ability to perform certain func-
tions. For example, it is correct to say, Despite his 
disability, he still was able to maintain employment.
Handicap describes a barrier or problem created by 
society or the environment. For example, The teach-
er’s negative attitude was a handicap to her. Or, The 
stairs leading to the stage were a handicap to him.
Deaf refers to profound hearing loss. Hard of hear-
ing may be used to describe any degree of hearing 
loss, from slight to profound.



Dutchess BOCES Style Guide and Communications Manual  12

Blind most frequently is used to describe a severe 
vision loss. Either blind or visually impaired are ac-
ceptable terms to describe all degrees of vision loss.
Developmental disability is any severe mental and/
or physical disorder that began before age 22 and 
continues indefinitely. Individuals with mental re-
tardation, autism, cerebral palsy, epilepsy and other 
similar long-term disabilities may be considered to 
have developmental disabilities.

Mental illness is a term describing many forms of 
illnesses such as schizophrenia, depression and 
emotional disorders. Use person with a mental 
disability rather than referring to an individual as 
deranged or deviant. Clinical terms such as neurotic 
and psychotic should be used only for clinical writ-
ing. Other terms such as demented, insane, abnor-
mal, deranged and mad often are used incorrectly 
and should be avoided. 

Percentages
Spell out the word percent except in scientific, tech-
nical and statistical copy, and express the amounts 
as numerals, except when it begins the sentence. In 
tables use the % symbol.

Eighty percent of the faculty attended the meet-
ing.
More than 90 percent of the class passed the test.

President
Capitalize when preceding a name.  Use lowercase 
for all other applications.

President Christopher Como. 

Quotation marks 
A period or comma always falls within quotation 
marks. A dash, semicolon, question mark or excla-
mation point go inside the quotation marks only 
when they apply to the quoted matter.

He yelled, “Stop!” Can you believe he actually 
yelled, “Stop”?

 • Direct quotation: When reporting the exact 
words of speakers or writers, surround their words 
with quotation marks.

“I have no intention of staying,” he said. 
For dialogue or conversation, place each person’s 
words in a separate paragraph, with quotation 
marks at the beginning and the end of each person’s 
speech. If a person speaks continuously for more 
than one paragraph, place quotation marks at the 

beginning of every paragraph in the speech, but do 
not place quotation marks at the end of paragraphs 
until the final paragraph in the speech.

 •  Single quotation marks: Use only when quotes ap-
pear inside a quotation. There are no spaces between 
the single and double quotations.

She said, “He told me, ‘I will arrive at class on time 
tomorrow.’”

Racial and Ethnic Identity
Specificity and respect are paramount when ad-
dressing racial and ethnic groups. It is usually not 
necessary to make distinctions between different 
people on the basis of ethnic heritage or ethnic 
identification unless it is important in understand-
ing characteristics of the population.  Identification 
by race is pertinent in biographical or announce-
ment stories when they involve an appointment that 
has not routinely been associated with a particular 
race or ethnic group, and when it provides the 
reader with a substantial insight into conflicting 
emotions likely to be involved in a demonstration or 
similar event.  
Preferences for terms referring to racial and ethnic 
groups change often.  Racial and ethnic groups are 
designated by proper nouns and are capitalized.  
Therefore, use Black and White instead of black and 
white.  For modifiers, do not use hyphens in multi-
word names, even if the names act as unit modifiers 
(e.g., Asian American participants). 
Depending on where a person is from, individuals 
may prefer to be called Hispanic, Latino, Chicano, 
or some other designation.  In general, naming a 
nation or region of origin is generally helpful (e.g., 
Cuban or Central American is more specific than 
Hispanic.  American Indian and Native American 
are both accepted terms for referring to indigenous 
peoples of North America.

Regions
Capitalize names of distinctive regions:  the East 
Coast, the South, the Northeast, Central New York.

Scholastic Aptitude Test
Capitalize each word. Use the acronym SAT on 
second reference.

Semester 
Capitalize the semester or term when used with the 
year:  Fall 2009; Spring 2010.
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Semicolon
Use a semicolon to separate multiple phrases when 
some of the phrases contain commas:  The library 
has an extensive microfilm collection; an audiovi-
sual department; facilities for typing, photocopying 
and studying; and archives, exhibits and special col-
lections. Use a semicolon to join main clauses not 
joined by coordinating conjunctions: 

The new house is almost complete; the interest 
rate is 9 percent.

Sexual Orientation
Sexual orientation is not the same as sexual prefer-
ence.  The term sexual orientation currently is the 
preferred term and is to be used unless the impli-
cation of choice is intentional.  The terms lesbians 
and gay men are preferable to homosexual when 
referring to specific groups.  If the meaning is not 
clear in the context of your usage, specify gender 
when using this term (e.g., gay men).  The clearest 
way to refer inclusively to people who orientation is 
not heterosexual is to write lesbians, gay men, and 
bisexual women or men–although somewhat long, 
the phase is accurate.

States
When standing alone, write out state names. When 
states appear in text with a town or city, write out 
the state or abbreviate using Associated Press (AP) 
abbreviations. Use Post Office (PO) abbreviations 
for mailing addresses only.

State Name  AP  PO
Alabama  Ala.  AL 
Alaska  Alaska  AK
Arizona  Ariz.  AZ
Arkansas  Ark.  AR
California  Calif.  CA
Colorado  Colo.  CO
Connecticut  Conn.  CT
Delaware  Del.  DE
District of Columbia  D.C.  DC
Florida  Fla.  FL
Georgia  Ga.  GA
Hawaii  Hawaii  HI
Idaho  Idaho  ID
Illinois  Ill.  IL
Indiana  Ind.  ID
Iowa  Iowa  IA
Kansas  Kan.  KS
Kentucky  Ky.  KY
Louisiana  La.  LA

Maine  Maine  ME
Maryland  Md.  MD
Massachusetts  Mass.   MA
Michigan   Mich.   MI
Minnesota  Minn.  MN
Missouri  Mo.  MO
Mississippi  Miss.  MS
Montana  Mont.  MT
Nebraska  Neb.  NE
Nevada  Nev.  NV
New Hampshire  N.H.  NH
New Jersey  N.J.  NJ
New Mexico  N.M.  NM
New York  N.Y.  NY
North Carolina  N.C.  NC
North Dakota  N.D.  ND
Ohio  Ohio  OH
Oklahoma  Okla.  OK
Oregon  Ore.  OR
Pennsylvania  Pa.  PA
Rhode Island  R.I.  RI
South Carolina  S.C.  SC
South Dakota  S.D.  SD
Tennessee  Tenn.  TN
Texas  Tex.  TX
Utah  Utah  UT
Vermont  Vt.  VT
Virginia  Va.  VA
Washington  Wa.  WA
West Virginia  W.Va.  WV
Wisconsin  Wis.  WI
Wyoming  Wyo.  WY
Vermont  Vt.  VT
Virginia  Va.  VA
Washington  Wa.  WA
West Virginia  W.Va.  WV
Wisconsin  Wis.  WI
Wyoming  Wyo.  WY

Students
Do not capitalize first-year, freshman, sophomore, 
junior or senior unless the word begins a sentence.

He is a senior communications studies major.
Do not capitalize class designations.

The senior class sponsored the lecture.

Student-athlete
Use hyphen rather than a slash to refer to student-
athletes.
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Temperature
Use figures unless the temperature is zero.

It’s minus 5 degrees. I hope it warms to 9 or 10.

Telephone numbers
Telephone numbers should be written as follows:

845.486.8051
845.486.4800, extension 303 or ext. 303
845.486.4840, extension 3030 or ext. 3030

That, which
There is a difference between that and which. Use 
that for restrictive clauses (clauses that are essen-
tial to the meaning of the sentence).  Use which 
for nonrestrictive clauses (clauses that, if removed, 
would not change the meaning of the sentence). 
Set off the nonrestrictive clause with commas. (If a 
sentence has two thats in it, and the reader may be 
confused, it’s appropriate to substitute a which for 
one of the thats).

The book that she wanted was not in the library.
The books, which are on the kitchen table, are 
overdue at the library.

Time 
Times should be written without a colon or double 
zeros, unless listing a specific time after the hour: 
The reception begins at 7 p.m., with dinner at 
7:45 p.m. In prose, the a and p and m in a.m. and 
p.m. should always be lowercase and followed by 
periods. The words noon and midnight should be 
lowercase. (Styles may vary for invitations and 
event listings.)

Title, entitle
Entitle means to give title to; title means to provide 
a title for or call by a title.

The author entitled the book last week; the book, 
titled How to Write Well, is here.

Titles  
(also see Academic titles and Composition titles)
Capitalize a person’s title when put before the 
name.

District Superintendent John Pennoyer
Do not capitalize titles when listed after a name, or 
titles that do not include a name.

Christine Riley, director of Human Resources, 
led the discussion.
Let’s invite the vice president of the Board of 
Trustees to the event.

Courtesy titles: The preferred use in periodicals 
and news writing is to drop the courtesy title in 
text material:  Smith rather than Mr. Smith. Omit 
the courtesy titles Miss, Mr., Mrs., or Ms. and use 
first and last names in the first reference. Use only 
the last name in subsequent references. Do not use 
Mr. in any reference to a married couple unless it is 
combined with Mrs. 

Mr. and Mrs. John Smith or Mr. and Mrs. Smith

United States
Spell out when used as a noun. Use U.S. only as an 
adjective.

She lives in the United States and carries a U.S. 
passport.

Web terms
Capitalize Web in terms such as Web site, Web page, 
and Webmaster. In text, it’s not necessary to enclose 
Web site or e-mail addresses in brackets, parenthe-
ses, or carets. Web sites and e-mail addresses should 
not be bolded, underlined or italicized.
Do not italicize, bold, underline or capitalize letters 
to emphasize Web addresses or place periods at the 
end of the address.  Other Web terms, and their cor-
rect spellings, include:
 • dot com (noun):  He returned to academe after a 

brief stint with a dot com.  
 • dot-com (adjective):  The city continues to feel the 

effects of the dot-com bust.
 • e-mail
 • home page
 • HTML: Hypertext markup language
 • HTTP: hypertext transfer protocol
 • Internet
 • login, logon
 • offline, online
 • Web, Webcast, Web page, Web site
 • World Wide Web

Who, whom
An easy way to determine which to use is to turn 
a clause into a sentence. Who is a nominative and 
therefore would match she or he, for example, in us-
age terms. Whom would match her.

Who:  Alice, who had been with the company for 
30 years, was eligible for retirement.  (She [not 
her] had been with the company for 30 years.)
Whom:  Whom should I ask?  (Should I ask her 
[not she]?
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Section Three:  Digital Letterhead Usage and Fonts

Digital Letterhead
Contents of CD
A CD with digital letterhead template and font usage is available.  To obtain a copy of this CD, please contact 
the Communications and Grants Research Division at 845.486.8051.  Please use the letterhead template for any 
letter initiated from Dutchess BOCES.  
A.  Two fonts for use in digital letterhead file

1. Futura (TT014M_.ttf)
2. Futura Italic (futurani.ttf)

To install fonts onto your computer:
Start>Control Panel>Fonts>File>Install New Font>In Drives Field, Navigate to Fonts Folder, Select All>Okay

B.  Letterhead Template file - “Jane Doe Letterhead.dot”
To customize letterhead file:
Launch Word.
File>Open>Jane Doe Letterhead.dot

Using fonts provided, customize name and contact information.
File>Save As>Rename the file (Name of person) Letterhead.dot. Be sure to save as .dotfile: 
Near the bottom of the dialog box Select Format>Document Template>Save

Do not alter header or footer, except to update file name and path field.

To update file name and path field in footer:
View>Header/Footer>Select File Name in Footer>Right Click>Update Field

Creating a multiple page letter or document (PC)
A.  Use the Dutchess BOCES letterhead document template to create page one

B.  To create blank pages beyond page one
1. Put your cursor AFTER the final character on current page
2. Go to >Insert >Break – choose Next Page
3. Go to >File >Page Setup >Layout tab – choose Different First Page

C.  For each additional page, repeat steps 1 and 2 above.
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Creating a multiple page letter or document (Mac)
A. Use the Dutchess BOCES letterhead document template to create page one

B.  To create blank pages beyond page one
  1. Put your cursor AFTER the final character on current page
  2. Go to >Insert >Break >Choose Section Break (Next Page)
  3. Go to >View >Header and Footer (or click in the Header area)
  4. Go to >View >Formatting Palette (opens a new Toolbox)
  5. From the Formatting Palette, select the Header and Footer tab
  6. Check “Different First Page”
  7. Click in the body of the document to close the Header

C.  For each additional page, repeat steps 1 and 2 above.

Adding a different Header or Footer to additional pages
  1. On your blank page, Go to >View – choose Header and Footer.
  2. Place the information in your Header and/or Footer.
  3. This information will remain constant for the remaining pages added to your document or letter.

Changing the Margin
For different on different pages in the Word template and/or Word document
Place your cursor on the beginning of the first line where you want to change your margins.

1.  Move your mouse to the top of your document and place on the ruler and grab the left “margin marker” 
(small square under the two triangle-shaped “indent markers”), dragging the square to where you want to 
place your left margin for the letter. Do the same thing on the right side ruler, grabbing the small triangle 
margin marker and dragging it to where you want to place your right margin.
2. FYI - On the left side, the top small triangle moves the first line indent. The bottom triangle is to move the 
second line indent (wrapped line indent). On the right side, the small triangle changes the right side margin.
3. Once you have changed both margins, those placements will remain the same as you enter your text until 
you manually change them to something different.

If you have questions, please contact the Communications and Grants Research Division at 845.486.8051.
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    John C. Pennoyer 
District Superintendent 

Dutchess County Board of Cooperative Educational Services 
Administrative Offices:  845.486.4800 

www.dcboces.org 

Participating Districts:  Arlington | Beacon | Dover | Hyde Park | Millbrook | Pawling | Pine Plains | Poughkeepsie | Red Hook | Rhinebeck | Spackenkill | Wappingers | Webutuck 

An Equal Opportunity/Affirmative Action Employer 

 
BETA-3.DATA2:shares:cgr group @ BETA:Communications & Style Guide - Dutchess BOCES:BOCES Letterhead template.doc 

Your Name 
Your Title 

5 BOCES Road, Poughkeepsie, New York 12601 
Phone: 845.486.4800 | Fax: 845.486.4981 
E-mail:  your.email@dcboces.org 
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    John C. Pennoyer 
District Superintendent 

 

Dutchess County Board of Cooperative Educational Services 
Administrative Offices:  845.486.4800 

www.dcboces.org 

Participating Districts:  Arlington | Beacon | Dover | Hyde Park | Millbrook | Pawling | Pine Plains | Poughkeepsie | Red Hook | Rhinebeck | Spackenkill | Wappingers | Webutuck 
An Equal Opportunity/Affirmative Action Employer 

 
BETA-3.DATA2:shares:cgr group:Communications & Style Guide - Dutchess BOCES:BOCES Letter Preferred Style 10-21-10.doc 

Your Name 
Your Title 

Your BOCES Address 
Phone: 845.123.4567 | Fax: 845.123.4567 
E-mail:  your.email@dcboces.org 

 
 
October 21, 2010 
¶ 
¶ 
Mr. John Smith, Vice President 
ABC Company 
876 West End Avenue, Suite 205 
Chicago, IL 60611-2846 
¶ 
Dear Mr. Smith: 
¶ 
This is an example of a block-style letter with mixed punctuation. Based on the size of the letter, the top margin should 
be anywhere from 1 inch to 1.5 inch to accommodate the letterhead logo and address, but our preference is that the 
document be centered vertically.  The side margins should be 1 inch. 
¶ 
Letters are usually keyed in single-spacing, with a double space between paragraphs. Block paragraphs begin at the left 
margin with no indentations. Every letter should begin with the date on which it will be sent. 
¶ 
Mixed punctuation means including the colon after the salutation and the comma after the complimentary closing. 
¶ 
Sincerely, 
¶ 
¶ 
¶ 
John C. Pennoyer 
District Superintendent 
¶ 
JCP:nmp 
¶ 
Enclosure 
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(Preferred Format Style for a Letter) 
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    John C. Pennoyer 
District Superintendent 

 

Dutchess County Board of Cooperative Educational Services 
Administrative Offices:  845.486.4800 

www.dcboces.org 

Participating Districts:  Arlington | Beacon | Dover | Hyde Park | Millbrook | Pawling | Pine Plains | Poughkeepsie | Red Hook | Rhinebeck | Spackenkill | Wappingers | Webutuck 
An Equal Opportunity/Affirmative Action Employer 

 
BETA-3.DATA2:shares:cgr group:Communications & Style Guide - Dutchess BOCES:BOCES Preferred Memo Style 10-21-10.doc 

Your Name 
Your Title 

Your BOCES Address 
Phone: 845.123.4567 | Fax: 845.123.4567 
E-mail:  your.email@dcboces.org 

 
 
October 21, 2010 

 
 
 
TO:  All Administrators 
 
FROM: John C. Pennoyer 
 
RE:  Style Guide for Written Documents 
 
 
(BODY TEXT GOES HERE) 
 
 
 
 
 
 
 
 
 
JCP:nmp 
N/BOCES/JCP/Correspondence/memo to admin re style guide/7-21-09 

 
 
IMPORTANT NOTE REGARDING ANY DOCUMENT:   
 
ALL DOCUMENTS, including those that ARE NOT composed on BOCES letterhead, must include the 
following information: 
 

1. Pagination - multi-page documents must be paginated -- 1 of 3, 2 of 3, 3 of 3, etc. 
2. At the bottom of every document, the file name and path must show the author, date, subject, etc.   This 

information can either be located in body of the document at the bottom OR in the footer (examples of 
this are noted in red text on letter (page 18) and memo (page 19) format styles).  

 

(Preferred Format Style for a Memo) 
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Dutchess BOCES Logo Standards
Because many people at Dutchess BOCES develop their own marketing materials, it is challenging to maintain 
a consistent look. Publications are geared for different audiences and age groups in many sizes and on many 
topics. Since people can benefit from a variety of different BOCES programs, making sure that individuals 
know they are “using” a Dutchess BOCES product or service is critical. Adding the logo is necessary to add 
name recognition and help build credibility.

All materials prepared for external distribution should have the Dutchess BOCES logo on them. Examples of 
these are:
Letters | Memos | Faxes | Reports | Proposals
Brochures | Advertisements | Announcements
There are two versions of the Dutchess BOCES logo.
Version 1: The name Dutchess BOCES is displayed on one line.
Version 2: The name Dutchess BOCES is displayed on two lines.
The one-line logo is also available with a division tag line.
The Dutchess BOCES logo color is PMS Reflex Blue. It may also be printed in Black.

Section Four: Dutchess BOCES Logo Usage

Version 1

Version 2

Logo with Tag Line
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MINIMUM SIZE

.5”1”

CLEARANCE AREA

Proper Use
The Dutchess BOCES logo is the primary visual ele-
ment used to identify the organization. The effective-
ness of the Dutchess BOCES logo depends on its 
correct and consistent use on all BOCES communica-
tions materials. Any incorrect or inconsistent usage 
will weaken the impact and will result in a diminished 
awareness of the Dutchess BOCES and its breadth of 
programs and services.
The logo should not be redrawn, rotated or altered in 
any way.

Proportion
The whole logo may be scaled proportionately.

Minimum Size
In order to maintain legibility, the minimum length of 
the one-line logo is one inch (1”) and is shown below. 
Minimum length of the two-line logo is .5”.

Clearance Area
Clearance is defined as the minimum distance al-
lowed between the logo and any other element 
(graphic, text or edge of page).
No matter what size the Dutchess BOCES logo is 
scaled to, the clearance area should never be less than 
the relative height of the BOCES block.

Background
The logo should not be placed on a background.

PROPORTION

IDEAL
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Logo and Digital Letterhead CD
A CD that contains the following information is available.  Requests for copies of this CD may be directed to 
the Communications and Grants Research Office at 845.486.8051.

CD Contents - Logos, Supporting Fonts and Digital Letterhead
Logo folder
A. Four files in .png format

1. 1-line black “Dutchess BOCES logo black 1 line.png”
2. 1-line blue “Dutchess BOCES logo blue 1 line.png”
3. 2-line black “Dutchess BOCES logo black 2 line.png”
4. 2-line blue “Dutchess BOCES logo blue 2 line.png”

B. Logo folder containing one-line logos with division tags

To insert logo in a Word document:
Insert>Picture>From File. Navigate to Logo Folder, Select a logo file>Insert
To enable repositioning of the logo in the Word document:
Select logo>Format>Picture>Layout>Select “In front of Text”
To resize logo proportionately:
Select logo. Holding down the shift key, click and slowly drag any corner bounding box handle.

Section Five: Dutchess BOCES Business Card

 

John Doe 
Title 
Dutchess BOCES 
Street Address 
City, State  ZIP 
www.dcboces.org 

voice: 845.123.4567, ext. 9876 
fax: 845.987.6543 

john.doe@dcboces.org 

 
 
Premier Educational and Support Services for our Community 

  

Use the following format for Dutchess BOCES business cards.  Business cards should be ordered through the 
Dutchess BOCES Print Shop 845.486.4800, extension 3006.
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Section Six: Dutchess BOCES Division Colors

BOCES Blue: Pantone Reflex Blue
CMYK values: 100/73/0/2
RGB values: 0/85/164
BOCES logo font: Griffin

HR  .......................................Pantone 202 U ........................................ (CMYK values: 10/97/61/48)

CGR  ....................................Pantone 7474 U  ..................................... (CMYK values: 14/19/21/38)

CTI  ......................................Pantone 7484 U  ..................................... (CMYK values: 100/0/85/50)

ER  ........................................Pantone 5115 U  ..................................... (CMYK values: 75/100/70/15)

F & O  ..................................Pantone 470 U  ....................................... (CMYK values: 0/58/100/33)

DS  ........................................Pantone 484 U  ....................................... (CMYK values: 0/95/100/29)

BS .........................................Pantone 556 U  ....................................... (CMYK values: 42/0/33/27)

AE/SE  ..................................Pantone 2955 U  ..................................... (CMYK values: 100/55/10/48)

Adult Ed  .............................Pantone 200 U  ....................................... (CMYK values: 0/100/63/12)
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Telephone: A Key Point of Customer Contact
Voice Mail Message
Hello, you have reached ___________ in the Dutchess BOCES ____________________________ Office.  I’m 
sorry I am unable to take your call at the moment. Please leave your name, phone number, and a brief message 
and I will get back to you as soon as possible. If you need immediate assistance, please dial ____________ and 
ask to speak with ______________.   Thank you and have a great day.

Voice Mail Away Message
Hello, you have reached _______________ in the _______________ Office at Dutchess BOCES.  I’m 
sorry I am not in the office today (or you can state specific dates that you will be away).  I will return on 
______________. If you need immediate assistance, please dial ___________ and ask to speak with 
______________. Otherwise, please leave your name, phone number, and a brief message and I will get back 
to you as soon as possible.  Thank you and have a great day.

(NOTE:  Promptly revise, update or reset your voice mail, as needed.)

Section Seven: Voice Mail Message



www.dcboces.org 25

Standard Telephone Message
Messages should be re-recorded at least every two weeks.

1. Message may begin with a salutation.
2. Dutchess BOCES should precede the department name.
3. All employees should use the same name to describe their department, office, or service.
4. All employees must use their name.
5. Message should end with “how may I help you?”

Sample Telephone Scripts
Standard Script
“Thank you for calling Dutchess BOCES, Educational Resources, Kip Newman speaking, how may I help you?”

Receptionist’s Script
“Thank you for calling Dutchess BOCES BETA, Denise Wrisley speaking, how may I direct your call?”

Secretary Answering Supervisor’s Line
“Good morning, Dr. Heitmann’s office, Pat Horgan speaking.  How may I help you?”

Taking Complete Messages
Treat your message pad like a checklist.

1. Name
2. District/company
3. Telephone number
4. Reason for the call (message)
5. Date and time

Things To Consider About E-mail:
 • E-mail should be written in standard English.

 • Incoming e-mail should receive a reply by the end of the next business day.

 • Use auto reply if you will be unable to read and respond to your e-mail.

 • Use a business card or your contact information at the end your e-mail.

 • E-mail is public information.

 • E-mail is often shared.

Section Eight: Telephone and E-mail Etiquette
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Section Nine: Notable News and Events Form

NOTABLE NEWS & EVENTS

Primary Contact ________________________________________________________________________

Title ___________________________________________________________________________________

Building Location _______________________________________________________________________

Phone & Extension ______________________________________________________________________

E-mail Address _________________________________________________________________________

NOTABLE NEWS & EVENTS INFORMATION:
What __________________________________________________________________________________

Where _________________________________________________________________________________

When (date & time) ______________________________________________________________________

Narrative Description (please use complete sentences)

_______________________________________________________________________________________

When requesting communication services or providing information for one of  our publications, please provide any 
back-up information that is available on event/activity, including hand-outs, programs, etc.  If  you would like us to 

cover an event, please try to give us two weeks’ notice, particularly if  you want us to send out a media alert.

     *New/modified Programs    *Events    *New Staff     *Communicator, Highlights, Spotlight Article
     *Staff/Student Recognition    *Special Projects or Performances    *Upcoming Courses

Anna Marie Paolercio
Director of  Communications and Grants Research
900 Dutchess Turnpike, Poughkeepsie, NY 12603

Voice:  845.486.8051 ~ Fax:  845.486.4958
E-mail:  anna.paolercio@dcboces.org

Please submit form to:

Photo opportunity?  ___ Yes   ___ No  If  yes, student picture release on file?   ___ Yes   ___ No

Administrator’s Name  __________________________________________   Date ___________________  
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Section Ten:  News Release and Media Alert
All news releases and media alerts for Dutchess BOCES are sent out using the following forms by the Commu-
nications and Grants Research Division.  To request a news release or media alert, please contact Anna Marie 
Paolercio at 845.486.8051 or e-mail anna.paolercio@dcboces.org.   

COMMUNICATIONS AND GRANTS RESEARCH DIVISION

ANNA MARIE PAOLERCIO, DIRECTOR

900 DUTCHESS TURNPIKE, POUGHKEEPSIE, NEW YORK 12603   
T: 845.486.8051 • F: 845.486.4958 •  WWW.DUTCESSBOCES.ORG

NEWS RELEASE

Headline  
TOWN AND STATE -– Date -– Enter Article Here  

Release Date:       Office:       

Contact:       Address:       

Telephone:              

Email:              

The following text may be added to the end of a news release or media alert:
Dutchess BOCES is recognized for its premier educational and support services providing quality and cost-ef-
fective solutions for our community. We promote an organizational culture fostering collaboration, innovation, 
efficiency, excellence and leadership that is embraced by BOCES and its community.

COMMUNICATIONS AND GRANTS RESEARCH DIVISION

ANNA MARIE PAOLERCIO, DIRECTOR

900 DUTCHESS TURNPIKE, POUGHKEEPSIE, NEW YORK 12603   
T: 845.486.8051 • F: 845.486.4958 •  WWW.DUTCESSBOCES.ORG

Event:
Date:         

Time:         

Location:         

Description:         

Other:       

Release Date:       Division:       

Contact:       Address:       

Telephone:              

Email:              

MEDIA ALERT
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OFFICE OF COMMUNICATIONS AND GRANTS RESEARCH 
Anna Marie Paolercio, Director ~ anna.paolercio@dcboces.org 

Voice:  845.486.8051 ~ Fax:  845.486.4958 
 
Macintosh HD:Users:annamarie:Desktop:PR Marketing Items:DUTCHESS BOCES PUBLICITY PERMISSION SLIP students under 18.doc 

Permission Form for Publicity Purposes 
(This form is intended for students UNDER the age of 18) 

I, the undersigned parent/guardian of _________________________________________________________ , 
                    (Name of Student) 

a student in the Dutchess BOCES, hereby give my permission for my child's photograph and name to appear 
on the Web site, www.dcboces.org, in the Dutchess BOCES newsletter, the Dutchess BOCES calendar, 
Dutchess BOCES brochures and/or other publications, school yearbook, local newspapers, videotaped 
recordings of student activities during the school day and after-school which may be broadcast and televised 
on local radio and/or television stations, on a non-paid basis. I understand that my child's name may or may 
not be mentioned and his/her voice, likeness, statements, actions or other information may be used in such 
recordings. The same applies to any interviews conducted for broadcast by local television or radio media. 
 
I release Dutchess BOCES, its officers, employees and agents, from any and all claims, demands, actions, 
causes of action, suits, damages and judgments as a result of the use of the above information about my child 
in the publications and/or media broadcasts described above while enrolled at Dutchess BOCES. 
 
I am over the age of 18, have read the above information, I understand the conditions of the above agreement 
and will be bound by its terms on my own behalf and on behalf of my child. 

Please print your name here__________________________________________________and sign below: 

Signature of Parent/Guardian ______________________________________  Date___________________  

Your Relationship to Child __________________________________________________________________  

Child's School __________________ Child's Grade ______   Child's Teacher________________________  
 
 
If you do not wish to have this information used by Dutchess BOCES in the manner described above, 
please complete this section: 

I, the undersigned parent/guardian of _________________________________________________________ , 
                     (Name of Student) 

DO NOT WANT the types of information described above regarding my child given to the local newspapers, 
used in Dutchess BOCES publications, the Dutchess BOCES Web site, the yearbook, or by local television 
and/or radio stations while enrolled at Dutchess BOCES. 

Please print your name here__________________________________________________and sign below: 

Signature of Parent/Guardian ______________________________________  Date___________________  

Your Relationship to Child __________________________________________________________________  

Child's School __________________ Child's Grade ______   Child's Teacher________________________  

PLEASE RETURN THIS FORM TO YOUR CHILD’S CLASSROOM TEACHER 

Section Eleven:  Permission for Publicity
STUDENTS UNDER THE AGE OF 18:
A Permission Form for Publicity form must be completed and on file for any Dutchess BOCES student prior to 
any form of publicity.  This authorization may be obtained as part of the student’s enrollment paperwork and 
kept on file in the main program office.  To obtain forms, contact the CGR Division at 845.486.8051.
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COMMUNICATIONS AND GRANTS RESEARCH 
Anna Marie Paolercio, Director ~ anna.paolercio@dcboces.org 

Voice:  845.486.8051 ~ Fax:  845.486.4958 
 
Macintosh HD:Users:annamarie:Desktop:PR Marketing Items:DUTCHESS BOCES PUBLICITY PERMISSION SLIP students over 18.doc 

 

Permission Form for Publicity Purposes 
(This form is intended for students OVER the age of 18) 

I, _____________________________________________________________________________________ , 
(Name of Student) 

a student at Dutchess BOCES, hereby give my permission for my photograph and name to appear on the Web 
site, www.dcboces.org, in the Dutchess BOCES newsletter, the Dutchess BOCES calendar, Dutchess BOCES 
brochures and/or other publications, school yearbook, local newspapers, videotaped recordings of student 
activities during the school day and after-school which may be broadcast and televised on local radio and/or 
television stations, on a non-paid basis. I understand that my name may or may not be mentioned and my 
voice, likeness, statements, actions or other information may be used in such recordings. The same applies to 
any interviews conducted for broadcast by local television or radio media. 
 
I release Dutchess BOCES, its officers, employees and agents, from any and all claims, demands, actions, 
causes of action, suits, damages and judgments as a result of the use of the above information about me in the 
publications and/or media broadcasts described above while enrolled at Dutchess BOCES. 
 
I am over the age of 18, have read the above information, I understand the conditions of the above agreement 
and will be bound by its terms on my own behalf. 

Please print your name here__________________________________________________and sign below: 

Signature _________________________________________________ Date ________________________  

Dutchess BOCES Course(s) or Program ______________________________________________________  

Teacher(s) ______________________________________________________________________________  
 
 
If you do not wish to have this information used by Dutchess BOCES in the manner described above, 
please complete this section: 

I,  _____________________________________________________________________________________ , 
(Name of Student) 

DO NOT WANT the types of information described above regarding me given to the local newspapers, used in 
Dutchess BOCES publications, the Dutchess BOCES Web site, the yearbook, or by local television and/or 
radio stations while enrolled at Dutchess BOCES. 

Please print your name here__________________________________________________and sign below: 

Signature _________________________________________________ Date ________________________  

Dutchess BOCES Course(s) or Program ______________________________________________________  

Teacher(s) ______________________________________________________________________________  

PLEASE RETURN THIS FORM TO YOUR TEACHER 

STUDENTS OVER THE AGE OF 18:
A Permission Form for Publicity form must be completed and on file for any Dutchess BOCES student prior to 
any form of publicity.  This authorization may be obtained as part of the student’s enrollment paperwork and 
kept on file in the main program office.  To obtain forms, contact the CGR Division at 845.486.8051.
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1-6-1:  One Teacher – 6 Students – 1 Supplementary School Personnel 

1-8-1:  One Teacher – 8 Students – 1 Supplementary School Personnel
1-12-1:  One Teacher – 12 Students – 1 Supplementary School Personnel
1-6-2:  One Teacher – 6 Students – 2 Supplementary School Personnel
1-8-2:  One Teacher – 8 Students – 2 Supplementary School Personnel
1-12-4:  One Teacher – 12 Students – 4 Supplementary School Personnel
AASA:  American Association of School Administrators
AEIA:  Adult Education Instructors Association
AESA:  Association of Educational Services Agencies
AHS:  Alternative High School
ALI - Adult Learning Institute
ARRA:  American Recovery and Reinvestment Act
ASA:  Administrative and Supervisory Association 
BETA:  BOCES Education and Training Academy
BFA:  BOCES Faculty Association
BOE:  Board of Education
BOCES:  Board of Cooperative Educational Services
CAC:  Cabinet Advisory Council
CAIT:  Curriculum Assessment and Instructional Technology
CGR:  Communications and Grants Research
CNA:  Certified Nursing Assistant
COSER:  Cooperative Service (approved by the State Education Department)
CSE:  Committee on Special Education
CSO:  Chief School Officer
CST:  Community Solutions for Transportation
CTE:  Career and Technical Education
CTI:  Career and Technical Institute
DAES:  Dutchess Academy of Environmental Studies
DEHIC:  Dutchess Educational Health Insurance Consortium
DCSBA:  Dutchess County School Boards Association
EDC:  Economic Development Corporation
ELA:  English Language Arts
EPE:  Employment Preparation Education
ER:  Educational Resources
ERAC:  Educational Resources Advisory Council 
E-Rate:  Federal funding for Internet access, LAN, and telecommunications
ESEA:  Elementary and Secondary Education Act
ESL:  English as a Second Language
ESY:  Extended School Year
FRN:  Federal Regulating Network
FTE:  Full-Time Equivalent

Section Twelve: Acronyms and Abbreviations
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GED®:  Tests of General Educational Development®
HHA:  Home Health Aide
HVAC:  Heating, Ventilation and Air Conditioning
IDEA:  Individuals with Disabilities Education Act
IEP:  Individual Education Plan
ITSAC:  Instructional Technology Services Advisory Council
JPC:  Joint Policy Committee
LAN:  Local Area Network
LEP:  Limited English Proficiency
LHCOSS:  Lower Hudson Council of School Superintendents
LPN:  Licensed Practical Nurse
LT:  Learning Technology
MHSSC:  Mid-Hudson Schools Study Council
NAESP:  National Association of Elementary School Principals
NA:  Nursing Assistant
NSBA:  National School Boards Association
NYSAWA:  New York State Association for Women in Administration
NYSCOSS:  New York State Council of School Superintendents
NYSED:  New York State Education Department
NYSESLAT:  New York State English as a Second Language Test
NYSSBA:  New York State School Boards Association
OT:  Occupational Therapy
PEACCE:  Providing Education for Autistic and Communication Impaired Children Effectively
PT:  Physical Therapy
QA:  Quality Assurance
RSE-TASC:  Regional Special Education Technical Assistance Support Center
RTT - Race to the Top
RWADA:  Resident Weighted Average Daily Attendance
SAANYS:  School Administrators Association of New York State
SBO:  School Business Official
SED:  State Education Department
SE-TASC:  Special Education Technical Assistance Support Center
SPC:  Salt Point Center
SSA:  Support Staff Association
STW:  School to Work
SYSOP:  System Operator
TSS:  Technical Support Services
VESID:  Vocational and Educational Services for Individuals
VI:  Visually Impaired
WAN:  Wide Area Network
WC:  Workers’ Compensation
WFW:  Wheels for Work
WIB:  Workforce Investment Board
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NOTES
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